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Introduction

Intuit ProFile Tax software is reliable and easy-to-use, and it offers sophisticated features that help tax preparers
experience a more productive tax season. The following paragraphs summarize the key components of Intuit
ProFile Professional Tax software

ProFile T1 imports and converts data created by competing software products. Whether you carry files forward
individually or in batches, you will find the process quick and convenient. Using ProFile’'s WYSIWYG (what you
see is what you get) forms, you can view and edit federal T1 and Québec TP1 forms in either French or English.
You can also print all tax forms in either language at the click of a button.

ProFile T2 is designed for professional preparation of corporate tax returns in all provinces and territories. ProFile
T2 includes:
e Federal T2 returns, including T2 RSI (for 2006-2009 and earlier) and Corporation Internet Filing
e Provincial corporate tax returns for Alberta (including AT1 RSI), for Ontario returns with taxation
years ending prior to January 1, 2009 (including CT23 disk filing) and for Quebec (CO-17).
e Provincial capital tax returns for Manitoba, Saskatchewan and British Columbia

ProFile T3 prepares Trust income tax returns and supporting schedules, including T3 and TS slips that the trust
receives. Simply enter slip information on intuitive income-reporting screens and ProFile T3 automatically
transfers the amounts to the appropriate forms. ProFile T3 also integrates business and rental income statements.
In addition to T3 slips, the software allows you to prepare NR4 slips for non-resident taxpayers (including the
NR4 summary).

ProFile FX (Forms Expert) gives you more than 80 of the most commonly-used CRA forms which supplement
the form-sets in Intuit’s other tax applications. Here are a few highlights of ProFile FX:

e Customizable options help you complete and file the forms you need.

e Automatic form selection facilitates form printing.

e Audit and review features help pinpoint potential errors

e Forms flexibility lets you print facsimile forms on plain paper or directly onto pre-printed CRA forms.
ProFile FX also prepares magnetic media files for T4, T4A, TS, T5018 and NR4 slips, as well as for the
RL1, RL2, RL3 and RL4.

e Import identification from an existing ProFile T1 or T2 data file minimizes potential data entry errors.




Benefits of Using ProFile

ProFile is powerful, efficient and secure tax software that helps you get your work done fast and efficiently.
Here’s how you benefit by using Profile:

e With phone, email or in-product live chat support, you have year-round access to knowledgeable
Canadian technical experts

e With its comprehensive set of forms and schedules, ProFile lets you handle just about every tax
scenario in any jurisdiction, including Québec

e  With a built-in auditor that runs up to 2,800 diagnostic checks of your tax returns, ProFile has your
back

e  Flexible Licensing means you can install ProFile on more than one personal computer without having
to pay additional licensing fees

e Work with QuickBooks? So does ProFile! There’s no need for manual data entry because you can now
export data from QuickBooks directly into ProFile

Plus, with ProFile you enjoy a consistent level of advanced features that include:

e Customizable client correspondence
e Database queries and reporting
e Online tools to quickly and easily stay in touch with your clients



Chapter 5: Advanced T1 Work

DEPENDANTS AND DEDUCTIONS

Now that you have learned the basics, let’s explore T1 preparation at a more advanced level.

Building on the previous example, assume that a married couple, Jane and Javier Cosan, submit additional forms.
e These forms include the following RSP slip

TD Waterhouse Canada Inc.
77 Bloor St. W.
Ii ' P.O. Box 5999, Station F
REGISTERED RETIREMENT Toronto, ON M4Y 2T1
SAVINGS PLAN
ATTACH TO FEDERAL INCOME TAX RETURN
DATE ACCOUNT  DURING THE FIRST 60 DURING THE REMAINDER CONTRIBUTOR'S NAME
NUMBER DAYS OF THE YEAR OF THE YEAR
Feb 28, 2018 8000.00 Jane Cosan
ANNUITANT 'S SOCIAL | CONTRIBUTOR'S SOCIAL
INSURANCE NUMBER INSURANCE NUMBER
Jane Cosan 444-444-442 444-444-442
12 Main St Contribution was in whole or D
Anytown, ON in part, in kind
M4A 1A2
(CANADA) and subject thereto. e D e

e And a schedule of Medical Expense

Medical Expenses
January - December 2017

Date Name Provider Memo/Description Amount Balance
01/24/2017 Jane Clear Sight Eyes Eyeglasses 1,478.50 1,478.50
211712017 Javier Barclay & Assoc Physiotherapy 170.00 1,648.50
04/21/2017 Javier Clear Sight Eyes Eyeglasses & Contacts 1,199.99 2,848.49
11/29/2017 Jane Barclay & Assoc Physiotherapy 370.00 3,218.49

$ 3,218.49

e Further assume that Jane submitted to you the following T4 and tuition slip for her daughter, Maria,
who is a full-time student at Concordia University

Caracs Reverne  Agerce o revers

..l Agency o Canada Tuition, Education, and Textbook Amounts Certificate Protected B/ Protégé B T2202A (16)

Certificat pour frais de scolarité, montant relatif aux études 1o comp romoli For student
et montant pour manuels ey Pour etudant

o ssue s Certcale 10 8 ShOBT WO Was eVOIRC CURNG The Calenca’ yea” in 8 Quaifyng o Délivrez ce Consficat & un étudan qul el inscrl. au Cours de [année Gvike. & un programme de
ecucabonal PrograT Of 8 soeched ecucabonal DOTET o & Post-secondary TSIRAON. such as lormaton acmsstie Ou & U programme de 'ormEtion OMerT e Cats N Matissement DUSISECONGaTe.
2 COlOge 0F uwersty O Al A AEITSO" 08740 Dy b OOy ™Rt anc Sanal Deveaoment £OM™Me T COMIGE DU AP LTSS Ou dans LA Hablesamant raCoNTU DA’ F DKo 8l v opDeTert
Canada (ESOC) socal Canada (EDSC)

@ Tut0" 106t DAE ~ "PROEC O the CABAAN yOa’ 10 ANy 06 AKITLO" Save 1 he Mmare ar @ L0 trars 00 SCOMNMS Payds & Un HADISSEMENT QUEICONQUE POUT UNE ANNGS CV COVEN! APasser
$100 Foos pad 10 8 POSH-8600NGAry NSITBON Aave 10 Do for COUrsas taken at the 1008 -vna.yau.mnmwm 78 A5 vent Viser 30 O 30 A vea
post-secondary level. Fees paic 1o an instiution cerifed by ESOC have 1o be 'or courses taken  postsecondare. Les rais payés & un élabissement reconny par EDSC doivert viser des cours suivis en
© get or mprove shdls " 8N OCCUDENO” mﬁnmmnuvenndvum’- vue ¢ BCQuén Ou U armélorer des Compétences Drofessomeles el Gludat SOt avor 16 ans ou Dlus
Botors the ond of the year avart &t %6 Tannee

» D0 not enter the cost of textbooks on this form Shucerts calcuiie e educaton and o Ninscrivez pas le codt des manuels sur ce formulaire | étucart caicue les montarts re! s sux
texibook amounts based on the number of months ndcaled » Box B or C below #tuces et pour manue's Caprés ke nombre de mols NSicub dans s cases B ou C G-dessous
Name o owan o7 Cowse Mo Ou prowaTie 0. 94 oy St rtw maro d it
Fine Arts 323122
Name 0 200wt O Stawr e o a3eie 3 1w oaT P
Maria COSAN
12 Main St

A "

Anytown ON M4A 1A2 CAN

2017, 01
09

Concordia University 2017

1455 De Maisonneuve Bivd W

Montreal QC H3G1M8

1o mtion 107 students See e Bace F 54 ¢ 7 you mant o Vaste ¥ 0 part
Reseignennts our s EUGIATS el & v 0. Teuler | & w0 e




Employer's name — Nom de femployeur IQI f"”‘“‘ Revenue sl;”cm %‘;W" T4
Hi-Test Resources Year Statement of Remune.rahon Paid
Année Etat de la rémunération payée
Employment income - line 101 Income tax deducted - line 437
Revenus d'emploi - ligne 101 Impdt sur le revenu retenu — ligne 437
MI 11.921[00 ||£| 775{65 I
3 54 | Employer's account number / Numéro de compte de lemployeur Province of employment  Employee's CPP contributions — line 308 El insurable earnings
£ Province d'emploi  Cotisations de I'employé au RPC - ligne 308 Gains assurables d'AE
(] 10 16 [ I 24 ‘ |
o
@ Social insurance number Exempt — Exemption I_m' 41684 11,9200
o Numéro sodale CPPIGPP _EI  PPIP  Employment code Employee's QPP contributions — line 308 CPP/QPP pensionable eamings
o [12]555 555 556 Code demploi _Cotisations de lemployé au RRQ - ligne 308 Gains ouvrant droit & pension — RPC/RRQ
c
5 ‘—' 29 17 | | 26 L |
o RPC/RRQ AE  RPAP ‘—‘_I 11,921,00
o Employee's EI premiums - line 312 Union dues - line 212
g Employee's name and address — Nom et adresse de l'employé Cotisations de l'employé  'AE - ligne 312 Cotisations syndicales — ligne 212
5 Last name (n captalleters) ~Nom de famite (en etres moudes) Firstname —Prénom il ntise \E‘ 194|31 | \ﬁ‘ l |
o
E Cosan Maria I RPP contributions — line 207 Charitable donations — line 349
> Cotisations & un RPA - ligne 207 Dons de - ligne 349
o 20 | 46 [ l
[}
=3 12 Main St Pension adjustment — line 206 RPP or DPSP registration number
g Facteur d'équivalence — ligne 206 N° d'agrément d'un RPA ou dun RPDB
o 52 I | 50 |
S Anytown ON CAN M4A 1L1
< Employee’s PPIP premiums — see over PPIP insurable eamings
B3 Cotisations de I'employé au RPAP - voir au verso Gains assurables du RPAP
o 55 | | 56 { |
°
2
2 Box-— Case Amount— Montant Box - Case Amount - Montant Box - Case Amount — Montant
gl L J T J0CJC T J[]
- see over)
a (¢ )
| Autres Box- Case Amount — Montant Box - Case Amount - Montant Box - Case Amount  Montant
< |renseignements
= | voir au verso)

Recording RRSP contributions

o With Jane and Javier’s tax return open, press F4, enter RSP in the Search field, and Profile will open
the RRSP/PRPP deduction form

/41 2017 T1/TP1: Cosan, Jane - RRSP/PRPP deduction
@ 1info| = 211013 | @3 T | @2s4| (8574|576 T183 O RRSP/PRPP I\;‘, 275 | [ & Donstions | [ g.Slips | + |

SRSEEREE RR RPP deductio

Verify unused amount from Box B Notice of Assessment or enter it as 'Prior to 2017'.

Contributions made to

Description Contribution period own RRSPs Spousal RRSP:

TDW March 1 to December 31, 2017 ] 8,000/00 J§ oloo
March 1 to December 31, 2017 | 0loo ojoo |

Subtotal 8.000[00 0loo

PRPP Contributions

Employee Contributions

e i - Made to
Description Contribution period own PRPP
January 1, 2017 to December 31, 2017 oloo |
Subtotal 0foo
PRPP employer contributions: January 1, 2017 to December 31, 2017
(amount from your PRPP contribution receipts) - report on line 205 0|00 I

Total RRSP/PRPP contributions

Contributions made to
Own RRSP/PRPP  Spousal RRSPs

RRSP contributions 8.000(00 f§ oloo il
PRPP contributions 0 gl
Subtotal 8,000[00 oloo i

Less:Designated Home Buyers' Plan (HBP) repayment 0Joo I

Designated Lifelong Learning Plan (LLP) repayment 0Joo I

Non-deductible contributions due to HBP or LLP withdrawal oloo 0]oo l

Refund of undeducted contributions included above 0[00 0 ﬂl
Total RRSP/PRPP contributions 8.000]00 0/00 .
< >

o  When entering RRSP contributions on this form, scroll down to enter or confirm the taxpayer’s

deduction limit (which you will find on CRA’s Notice of Assessment). Note that ProFile will not allow
an RRSP deduction until you fill in this field.



/4 2017 T1/TP1: Cosan, Jane - RRSP/PRPP deduction =R
@ Linfo| = 2T1013 |3 T1| @454 (2574|576 T183 D RRSP/PRPP ];, 775 | [ & Donations | [J &.5lips | + |

~

RRSP/PRPP deduction limit
Option 1: Enter limit from 2016 Notice of (Re)Assessment 18.523 I

Option 2: Calculate the limit

2016 earned income 102911 X18% 18.523 MA
Lesser of A or $26,010 18,523
[ |

Less:Pension adjustment from 2016 T4/T4A slips

2017 past senvice pension adjustment ofl
Plus: 2017 pension adjustment reversal from T10 slip 0 I
Subtotal 18,523 |
Plus: Unused RRSP/PRPP deduction room from 2016 0 I
Subtotal 18,523 |§
Less: Saskatchewan Pension Plan deduction of
RRSP/PRPP deduction limit for 2017 18,523
RRSP/PRPP summary
2017 RRSP/PRPP deduction limit 18.523
Eligible income transferred to your RRSP/PRPP 0
Subtotal 18.523 18.523 I B
RRSP/PRPP contributions to March 1. 2018 8000 §C
RRSP/PRPP deduction (lesser of lines B and C) 8,000 I D
RRSP/PRPP contributions carried forward to 2018 (C - D) ] I
SPP contributions carried forward 0 I

Repayments under the Home Buyers' Plan

Option 1: 2017 required repayment from 2016 Notice of (Re)Assessment 0|00 I
HBP Outstanding balance oloo |}

>

~

Entering Medical Expenses
e To optimize a married couple’s tax return, you will want to combine and claim medical expenses on
only one of the spouse’s returns. Assume, therefore, that you have decided to enter the medical
expenses on Javier’s T1
e OnJavier’s T1, press F4, enter Med in the Search field and ProFile will open the Medical Expenses
form
e Enter the medical expenses as illustrated below

\/ 4 2017 T1/TP1: Cosan, Jane - Medical expenses oo )=
211013 | @371 | wasa| 25T4| P8 T183| D RRSP/PRPP  [J 1. Medical I_;, 7 TS| [ 8 Donations | [J 9.Slips | + |
Medical H
Medical expenses
Optimize medical expenses? ~ Yes []  No
Medical expenses - line 330
Period covered by claim: from 2017-01-01 to 2017-12-31 l
l Payment date Name of patient [ Payment made to | ::::;‘::‘;: 'f":‘g:g‘:“ Amount ‘ Claim ‘
2017-01-24 _|Jane Cosan Eveglasses o 1.478]50 i 1.478[50 |}
2017-02-17 _|Javier Cosan Physio o .| 70{00 17000
2017-04-21 _|Javier Cosan Eyeglasses o . | 1.199|99 1.199|99
2017-11-29 [Jane Cosan Physio o .| 70/00 | 370[00 @
[yyyy-mm-dd I o | oloo | ojoo @
Medical expenses subtotal | 3218[40
Are you claiming medical expenses? No ]
Taxpayer Spouse
Premiums paid to private health senvice plans 0/oo 0[oo
Employee/Recipient-paid premiums for private health services plan 0/oo 000
Québec prescription Drug Insurance Plan - 2016 0[00 0[oo
Nova Scotia Seniors' Pharmacare Program o[oo oloo oloo |
Total medical expenses - line 330 0[00 I
Allowable amount of medical expenses for other dependants - line 331
Name of other dependant |8 Net income 0[oo
Payment date Payment made to | Description of expense I.s““n:‘:n“n.‘," | Amount Claim
[vyyy-mm-dd_| [ [No | 0[00 0]00
Total medical expenses 0[00
Are you claiming medical expenses for this dependant? No
Minun- Q0L aflinn D8 af'n ratiien (mavimim € 2821 alnn B hd

Recording Dependant Information

e With all of the spouses’ information entered in ProFile, the last step is to record the slip information for
the Cosan’s daughter, Maria. To do this, you will use a feature called Family Linking.




FAMILY LIN

KING

Cosan, Javier

v Cosan, Maria

Q E;] When you create a dependant’s tax return, ProFile will link the return with that of the
1 parents. You can tell Family Linking is enabled by the toolbar icon and dropdown
menu that lets you toggle amongst the family’s tax files.

e  With the spousal return open, Press F4 and enter Dep in Form Explorer’s Search field

e Enter

Maria’s personal information on the Dependant information form

Dependant

Family caregiver amount claimed by

/4 2017 T1/TP1: Cosan, Jane - Dependant information oo )=
@W3T|was|(2574| 5 67183 | O RRSP/PRPP | [J 1.Medical &% 2 Dependant l\;z. 75| [ & Donations | [J 9.5lps |+ |

Avre you eligible to receive the Child Tax Benefit? Yes No D

Dependant information

You Spouse |:|

Dependant #1 Dependant #2 Dependant #3
»
| Social Insurance Number 555 555 556 " .|
First name Maria | |
Last name Cosan
[ Relationship Daughter N/A IN/A
Birth date 1998-06-24 lyyyy-mm-dd lyyyy-mm-dd
let income 0.00 0.00 0.00
Claim as eligible dependant? No No
Dependant claiming GST credit? Yes No No
Dependant claiming PST No No No
credit (MB)?
Did you or your spouse or No No No
common-law partner receive child
assistance payments from
Retraite Québec for December 20177
Did dependant live with you in 20177 |Yes No No
Street address 12 Main St
P.O. Box, RR.
Apt No.
City |Anytown
Province ON
Postal code M4A 1A2
Province of residence on 2017/12/31 |Ontario HNA HNA
Disabilitv/infirmity v

e To create a T1 file for Maria, right-click on any field in the form and select Return for Maria

Family caregiver amount claimed by

\/ 4 2017 T1/TP1: Cosan, Jane - Dependant information
W3t | «ast|(a5T4| 5 67183 | O RRSP/PRPP | [J 1.Medical &% 2. Dependant |\;1. 5| [ & Donations | [

Ave you eligible to recsive the Child Tax Benefit? Yes No [J

You Spouse |:|

Dependa Dependa D
<
Social Insurance Number 555 555 556 |
First name a =
Last name Cosan ——
Daui}er Return for Maria A
Birth date 1998 Emm— T
Net income 0 Cut
Claim as eligible dependant? No Copy
Dependant claiming GST credit? |Yes et
Dependant claiming PST No 24
credit (VIB)? Paste
Did you or your spouse or No
common-law partner receive child nsedcolumn
assistance payments from Delete column
Retraite Québec for December 20172
Did dependant live with you in 20172 |Yes Attach memo F8

et pPRSSA N

ARSI L AN N s A A

e ProFile will confirm that you want to create a tax file for Maria. Click OK

Confirm

n ProFile

Create a new return

X

for Maria?

Gancel



e From Maria’s tax file, return to Form Explorer and enter Maria’s T4 and T2202 (tuition) information

Tuition fees paid

/4 2017 T1/TP1: Cosan, Maria - Statement of remuneration paid E]E
@1info|f@2T B3T4 ] & 4T220m01| + |
T4 = ~
Statement of Remuneration Paid T4 SII .
p p p p #4 ota
4 1D
Description HiTest
Resources

Province of employment Ontario .| .|
Employment income 11,921.00 | o000 i 000 i 0.00 11,921.00
Employee’s CPP 41684 ooo i ooo i 0.00 416.84

QPP o000 i o000 i 000 i 0.00 0.00

El premiums 10431 1 ooo i ooo i 0.00 194.31

PPIP 55 0.00 000 i 000 i 0.00 0.00
et (E:IPP/ L mg /41 2017 T1/TP1: Cosan, Maria - Tuition and education credit certificate [E=REcE ==

PPIP No @1info |@2T|(83T4 BaT2OMN | L |
Employment code 29 T2202AMLA1 e = -
REE _conml_:u!mns 2 0.00 Tuition and education credit certificates TU|t|0n SII . S
Pension adjustment 52 0.00
Income tax deducted 2 77565 Box Slip #1 Slip #2 Slip #3 Slip #4 Total
El insurable eamings 24 11.921.00 < »
CPP/QPP pensionable earnings 26 11.921.00
PPIP insurable earings 56 0.00 Wl | pescri Concordia U
Union dues 44 0.00 -
Charitable donations 46 0.00 T2202A, TL11A, TL11B, TL11C

6.615.27

Tuition fees paid before September 5™ 2017 3,285.47 || 000§ [ | ey | 3,285.47
Number of months in part-time enrolment B ofl ofl ofl ofl 0
. before September 5™ 2017 ofl ofl ofl off 0
Number of months in full-time c | ofl ofl ofl 8
__ before September 5 2017 4 0 0 0 4

Tuition fees paid before September 5 2017
Charitable donations

Tuition transfers
When a student’s income isn’t high enough to use up all of the tuition credit, CRA allows that student to transfer
the excess credit to a family member. ProFile takes care of this transfer automatically. It does so by a process
called optimization.

e Because Maria had excess tuition expenses, ProFile automatically transfers the applicable tuition credit

to the appropriate spouse. A quick glance at line 324 on the S1 form of Javier’s T1confirms the transfer

Inter paid onyour S| uenan
Your tuition, education, and textbook amounts (attach Schedule 11)
Tuition amount transferred from a child

Amounts transferred from your sp
Medi

or common-law partner (3

h Schedule 2)

There is a setting in ProFile that toggles family linking on or off. To make sure that this setting is enabled, go to
Options > Module and scroll down, under the General tab, to the section that reads “Allow family linking.”




Module Options ? X
22017 T1/TP1 v|l320162019T2 v | [ 52018 T3TPE4 v | B§82017Fx <[
File Template
“ | Browse
General Datalocking Variance Disclaimer T1/TP1 Review
[ Complete line 6509 LD
X Joint client letter @®English
B Joint clientinvoice OFrench
] Automatica arry forward "Form Selection” settings
87" Calculation options
[ Allow family linking
CiGamplate MaxinenTUAS
X Recalculate invoice on data locked returns
& File naming
® Long names
O Long with SIN
S tmaurie?
Q© Long using SINs
O Client reference number © Cancel
< > Help

As mentioned in the previous paragraph, ProFile provides seamless, invisible optimization, and it alerts you with
audit messages designed to achieve the most beneficial tax results for a tax preparer’s clients.

Here is what ProFile’s optimization prowess includes: medical expenses; donations and losses; foreign tax credits;
advantageous caregiver and infirm dependant claims between spouses; smart disability credit transfers; and
intelligent transfer of tax credits between taxpayers and their dependants.

Pension Splitting
Splitting pension income is another example of ProFile’s optimization capability. Let’s look at an example.

The Tax Summary below shows that Mary earns significantly more that her spouse, Frank, and it also reveals that
Mary has pension income of $48,950. There is an opportunity, therefore, to split the pension income and reduce
the couple’s overall tax liability.

Summary

Total income

Old Age Security
CPP/QPP benefits

Other pensions
Split-pension amount
Universal Child Care Benefit

Tsxable dividends
Interest

Limited

RDSP

Rental

Tsxable capitsl gains
Support

RRSP

Other

Self.
Workers' compensation and
social assistance

Total income

Netincome

RPP

RRSP * 0 0 W Total p:
0

Split-le’gn Deduction ~ -~

e To optimize pension income, go to the pension-transferor’s return and open form 77032
e Scroll down the form and click Split-Pension Income



Protected B
when completed

r Step 3 - Elected split-pension amount
For assi: in ining the elected split ion amount, see our Split-Pension Income wofksheet.

Enter the amount that you and your spouse o common-law partner decide to jointly o

split pension amount for the year. The split-pension amount cannot be more than the amount from Line F. G
Enter this amount on line 210 of the transferring spouse or common-law partner’s return and on line 116 of

the receiving spouse or common-law partner’s return.
r Step 4 - Pension income amount (line 314)
Part A - Calculate the pension income amount of the ing spouse or law partner.

(Amount from line A 48.950.001 [}
B s A v _ -

e ProFile opens the T/0320pt pension worksheet form. Right-click the form and select Optimize split
pension income

T10320pt e = = =
Optimize - Split-pension income
Information for the elected split-pension amount
[ The Spiit-Pension Income optimization worksheet helps you determine the amount, i any, to enter on line G of the T1032 - Joint Election to
Spiit-Pension Income.
To view the amount that we suggest for transfer, right click on the worksheet and select Optimize split-pension income:
For addtional information, press <F1> to access help for this worksheet.
Calculation of the elected split-pension amount Copyfield code
Zero transfer  Suggested transfer ~ Calculator Copy Memo/Tape
Scenario #1 Scenario
Paste Memo/Tape
Elected spit-pension amount 000 00 0.00 0 Closeform Esc
Tiay 000 0 o e
Total payable (ine 435) [Frank 000 00 00 0
Combined 0.00 00 00 g =T
Mary 0.00 00 00 0. Launch window
Balance owing / refund [ Frank 000 00 00 0 Cmerx
[Combined 0.00 00 00 0 5
Combined net benefit (cost) 00 00 0. Create T3
Carry forward
Maximum spit-pension amount from line F of your T1032) 2447500  Previous year's retum
Please enter the split-pension amount you wish to transfer to Frank. Show suditor CuleFo
[This amount will appear on line G on your T1032 Elected split-pension amount 000| .

e Agsillustrated in the window below, ProFile will run an analysis and then suggest the pension income to
transfer
e The form highlights the net benefit of accepting the suggested transfer

e And it also provides a chart outlining the tax liability with different transfer amounts B
e To accept ProFile’s suggested transfer, right-click the form and select Elect split-pension amount of

$24.475 @

Calculation of the elected split-pension amount

< >
Elected spit-pension amount ) 2447500 00
lary 43533 32,003.13 | 00
Total payable (line 435) [Frank 3,688, 11.044. 00
Combined 47,222 43,047 00
Mary 20.374. 14,844
Balance owing / refund | Frank 311.71) 108422 € Eiect i wsza,m.m
Combined 20,062.9 15.,888.35 | S
Combined net benefit (cost) 4174 Copy field code
Summary of the elected split-pension amount Copyiemaliiee]
Paste Memo/Tape

We have determined that transferring $24,475.00 to Frank's retum will result in the lowest combined total payable. If you elect to transfer t

suggested amount, the balance owing of $20,062.97 is dcreased to $15,888.35. This represents an overall savings of $4,174.62. &=
Maximum split-pension amount (from line F of your T1032) 2 475.00}
Please enter the split.pension amount you wish to transfer to Frank.
This amount will appear o ine G on your T1032. Elected split pension amount 0.00
Create FX
Impact of electing a split-pension amount on your combined total payable . ": i
Carry forward
op0
Combined | 4 ¥
total Show auditor Ctri+F9
payable | . 5
(line 435)
«l
S0 s2e S4E9s  Sa2 SO70 12207 S14685 ST SIS0 S22027  S26475
BT unt (max S24,475.0

You can learn more about optimizing, go to Help > ProFile Help, click the Search tab and enter “Optimizing” in
the Search field
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PROFILE AND THE SELF-EMPLOYED

As professional-grade tax software, ProFile can accommodate many types of income-generating scenarios.
Examples include rental income, investment income and income from self-employment. This section will
illustrate ProFile’s ability to accommodate the latter scenario.

Sam Hruzec, runs an un-incorporated marketing business called SH Marketing Services. Sam has asked you to
prepare a T1. Sam has no income or expenses, other than the Statement of Revenue and Expenses below.



SH Marketing Services
P&L
Jan - Dec 2017
PBC
Revenue 91,773
Total Revenue
EXPENSES
Accounting Fees 4,800
Advertising & Promotion 1,447
Bank Service Charges 1,547
Office supplies 1,398
Telephone 626
Travel Expense 780
Vehicle Expenses
Biz KM 3255
Total KM 10061
Fuel 827
Insurance 914
Repairs 637
Parking 112
Home Office Expenses
Total space 1695
Business use space 317
Insurance 628
Rep/Maint 1775
Heat 1288
Hydro 764
Prop Tax 3840
T2125

You will record all of Sam’s business-related revenue and expenses on form T2125, Statement of Business or
Professional Activities. After entering Sam’s personal and contact information on the Info page, use Form
Explorer to find and open the 72125




W4 Form Explorer ? X
el H v &
&l Huzec, Sam 1 Lo ':i_’ t4 LT
Fom: 12129 Open  Pint  New | List Detail Key Line
Forms Name Category Description Used Lastyear Step &
T ez T2091WSH Income Principal Residence Worksheet No NZ& ]
; T21218 Income Fishing activities No N/& 83
AR T2121CCASum... - Income Summary of CCA for fishing activities No NA 90
2 Slips “1T2121CECH Income Cumulative eligible capital for fishing activi..  No NZ& a1
3 Income T2 21Assetht Income Asset details No NZ& 92
4 Deducti T3 T2121AssetListt  Income Asset list No NZ& 94
& Deelons | 4 11210088 Income Detais of CCA No  NA 93
5 Tax+crediv| | =4 T2121Compara... Income T2121 - Comparative summary No N/ 95
TiT21258 Income Business activities No N/ 96
TP1 - " e ey — " P il e v
[T2125#:Business activities

Here’s how to complete form T2125

e Enter the business contact details and other required information under identification area, and record
the gross sales under Part 1 — Business Income

— Part 1 - Identification

Name Hruzec, Sam Your social number 238 137 848
Business Name Business Number

SH Ent (15 RT

Business address

Number _ Street, P.O. Box Apartment or suite

1212 !Rue Principale

City Province or territory _ Postal code

Montreal Hac MHoH oH

Fiscal Period Was 2017 your last year of business?  Yes | | No

From: Year/Month/Day Year/Month/Day
2017-01-01 to: 2017-12-31 ICaIendarYear

Main product or service Industry code (press F6) 811119

Promotion (see the appendix in Guide T4002)

Tax shelter identification number Partnership Business Number Your percentage of

TS (9 digits) the partnership
100.0000 | %

Name and address of person or firm preparing this form
ABC_IMPOT

1445 Stittsville Main St

Stittsville, Ontario

— Part 2 -Internet b

If your webpages or websites generate business or professional income, fill in this part of the form.

How many Intemet web pages and websites does your business earn income from? Enter "0" if none. 0 I

Provide up to five main webpage or website addresses, also known as uniform resource locator (URL):

htp:/

Percentage of your gross income generated from the webpages and websites.

(If no income was generated from the Internet, enter "0".) 0.0000 I %
T1139: Last year additional business income (T1139 line G) oloo i
— Part3A- i income

2 If you have business income, tick this box and complete this part. Do not complete parts 3A and 3B on the same form.

Type of income Business Commission

Gross sales, commissions, or fees (include GST/HST collected or collectible; 91.773[00 I

Income reported on T4 slips 0]oo

Income reported on T4A slips 0]oo i

Fees for senvices (T4A box 28) 0/00

91.773[00 g1

Minus Goods and senvices tax and provincial sales tax (GST and PST) or harmonized

sales tax (HST) (if included in sales above) 0|00 I
Returns, allowances, and discounts (if included in amount 1) 0|00 l
0j00 @2
Subtotal : Amount 1 minus amount 2 91 773 3

e Record all business expenses in Part 4 of the T2125



r— Part 4 - Net income (loss) before
Gross business or professional income (line 8299 of Part 3C) or Gross profit (line 8519 of Part 3D) 91.773|00 l a
Expenses (enter only the business part)
Advertising 8521 1.447[00 |
Meals and entertainment 0|00 I x 50%
Meals and entertainment (long haul truck drivers) 0foo |l x 80% 0Joo
Bad debts 0[00
Insurance 0|00
Interest 1.547)00
Business taxes, licences, and memberships 0|00
Office expenses 1.398/00
Office stationery and supplies 0[oo
Professional fees (includes legal and accounting fees) 4.800/00
Management and administration fees 0|00
Rent 0|00
Repairs and maintenance 0[00
Salaries, wages. and benefits (including employer's contributions| 0joo
Property taxes 0]00
Travel expenses 780/00
Utilities 62600 |
Fuel costs (except for motor vehicles) 0[00
Delivery, freight, and express 0joo
Motor vehicle expenses (not including CCA)
see Chart A) - from worksheet 88135 |
Motor vehicle expenses (not including CCA)
(see Chart A) - other oloo HEEEX 88135 Ji
Capital cost allowance (from Area A) 9936 0|00 i
Allowance on eligible capital property 0[o0 i
0j00

Convention fees 0[00
Private health senices plan premiums 0joo I
Resenes 0[o0 I
Terminal loss 0Joo i

Other expenses = oloo HEEQ o0loo

Total expenses: Total of the above amountsfelad  11.479[35 | » 11.479]35 b

Net income (loss) before adjustments: Amount a minus amount b EEI 80.293|65 I

o Note, however, that you don’t record vehicle expenses on the T2125 itself, but on the Business Auto
ancillary form (see illustration below), and you indicate, at the top of the Business Auto form, where to
send the vehicle expenses

Here are other key points to consider with the Business Auto form

e  You must indicate the business kilometers and the total number of kilometers driven in the tax year.
ProFile uses these values to calculate the allowable vehicle expense

e Any vehicle loan or leasing costs are calculated in a separate area of the Business Auto form. See Chart
D, at the bottom of the window below, which is where the eligible leasing cost is calculated

Business Auto H H
Motor vehicle expenses (Business
Allocation of expenses s EREs} peméd d
T2125#1:SH Ent
Chart A - Motor vehicle expenses
Description of ile Filmore
Enter the kilometers you drove in the tax year to eam business income 3.255 @1
Enter the total kilometers you drove in the tax year 10.061 | 2
Taxable Non Eligible Total
G HST
Fuel and il oloo il oloo i 827]00 s27]00 § 3
Interest (see Chart B) 0Joo ojoo W 4
Insurance 914/00 914/00 @ 5
License and registration 0Jo0 ojoo W 6
Maintenance and repairs oloo J§ oloo i 637/00 537)00 lf 7
Leasing (See Chart D) ojoo ojoo 0loo ojoo i 8
Other expenses (specify) ojoo § ofoo oloo ojoo f§ 9
0[00 0[00 0[00 0[00 @ 10
Total motor vehicle expenses 0joo 0[o0 2.378|00 2.378j00 @ 11
Business use part: Multiply line 11 by 3235 | % oloo l§ oloo i 769)35 ] 769]35 JJ 12
Business parking fees ojoo J§ oloo i 112Joo ] 112Jo0 J§ 13
Supplementary business insurance 0|00 I 0|00 I 14
Allowable motor vehicle expenses oloo J§ oloo i 88135 J§ 88135 J§ 15
Chart B - Available interest expense for passenger vehicle
Date interest payments commenced 2017-01-01
Date interest payments terminated 2017-12-31
Total interest able (accrual method) or paid (cash method) in the fiscal period 0.00 W (A)
The number of days in the fiscal period for which interest
was payable (accrual method) or paid (cash method) 365 X 10.00 = 3.650.00 @ (B)
Available interest expense (amount A or B, whichever is less) (enter this amount on line 4 of Chart A above;] 0.00
Chart C - Capital Cost Allowance for motor vehicles

One further step in recording Sam’s business expenses is to enter the allowable home office expense. As a self-
employed individual working from home, Sam can deduct a portion of her home expenses. This portion is




calculated by adding up all of Sam’s home expenses and multiplying it by a factor that represents the percentage
of the home’s area used to run her business.

e To record home expenses, scroll down to Part 7 at bottom of the T2125

e Enter the home’s total area and the area used for business

e Enter the operating costs for the home including heat, electricity, insurance, etc.

[ )

ProFile will calculate the allowable home office expense and include as an eligible business expense on
the T2125

— Part7-C. ion of busi f-h expenses
Area of home used for busi (A) 317 I
Total area of home (8) 1695 |}
Heat 1.288/00 |1
Electricit 764J00 2
Insurance 628/00 I3
i 1.775/00 4
Mortgage interest 3,840[{00 W5
Property taxes oloo |6
Other expenses (specify):
0joo @7
Subtotal: Add amounts 1to 7 8.295/00 @8
Minus: Personal-use part of the business-use-of-home expenses 6743166 B9
(Amount 8 minus amount 9) 1.551[34 I 10
Plus: Capital cost allowance (business part only), which means amount i of Area A minus any portion of
CCA that is for personal use or entered on line 9936 of Part 4) 0loo I 1"
Amount carried forward from previous year ooo | 12
Subtotal: Add amounts 10 to 12 1.551|34 #13
Minus: Net income (loss) after adjustments (amount e of Part 5) (if negative, enter "0") 80.293[65 | 14
B -use-of-home exp i to carry forward: Amount 13 minus amount 14
if negative, enter "0") 0]o0 I 15
Allowable claim: The lesser of amount 13 and 14 above (enter your share of this amount on line 9945 of Part &) 1.551]|34 16

After entering all required information on the T2125, ProFile will calculate the gross and net business income and
transfer it to the T1 Jacket.

Step 2 - Total income
As a resident of Canada, you have to report your income from all sources both inside and outside
When you come to a line on the return that applies to you, go to the line number in the guide for m

Employment income (box 14 of all T4 slips) 101 0|00

Commissions included on line 101 (box 42 of all T4 slips) 102 O]OO i

Wage loss replacement contributions

(see line 101 in the guide) 103 oloo §

Other employment income [104] oloo i

0ld Age Security pension (box 18 of the T4A(OAS) slip) 113 oloo |

CPP or QPP benefits (box 20 of the T4A(P) slip) 114 0joo |

Disability benefits included on line 114

(box 16 of the TSA(P) siip) 152 0loo

Other pensions and super i [115] 0]00

Elected split-pension amount (attach Form T1032) [116] 0{00

Universal Child Care Benefit (UCCB) 117 0[oo

UCCB amount toa 185 0]00 i

Employment insurance and other benefits (box 14 of the T4E slip) [119] 0{00 i

Taxable amount of dividends (eligible and other than eligible) from taxable Canadian

corporations (attach Schedule 4) 120 0{00

Taxable amount of dividends other than eligible dividends,

included on line 120, from taxable Canadian corporations 180 0]00 i

Interest and other investment income (attach Schedule 4) ﬁ 0

Net partnership income: limited or non-active partners only 122 0

Registered disability savings plan income 125 0

Rental income GrossW\ OIOO i Net|126 0

Taxable capital gains (attach Schedule 3) 127 0

Support payments received Tutalm 0|00 i Taxable amount|128 0

RRSP income (from all TARSP slips) 129 0

Other income Specify: 130 0

Self-employment income
Business income Gross[162] 91.773 Net[135] 78,742
Professional income Gross [164 0 Net[137 0
Commission income Gross |166 0 Net|139 0
Farming income Gross [168 0 Net[141 0
Fishing income Gross 170 0 Net[143 0

Workers' compensation benefits (box 10 of the TS007 slip) 0[00

Social assistance payments 145/ 0[00

Net federal (box 21 of the T4A(OAS) slip) 146 0]00

Add lines 144, 145, and 146

(see line 250 in the guide). 0[00 |» 147 0[00

Add lines 101, 104 to 143, and 147 This is your total income. |150 78.742(31




PART-YEAR RESIDENTS

In this section, we’ll briefly describe how to set up ProFile for newly-arrived residents.

Working on a part-year resident return

If someone is newly arrived in Canada, follow these steps to set up a T1 return.
o Complete the Info page as you normally would. So that ProFile can prepare the proper schedules,

ensure that you select the correct province of residence

e Report the date of entry into Canada 2
e After reporting the date of entry, ProFile will open additional fields, including Line 5292 and 5293. In

these fields, report Canadian and foreign-sourced non-resident income. In this example, there is

$10,000 of foreign-sourced, non-resident income B

e Once you enter an amount on either Line 5292 or 5293, ProFile will tick the box to prorate non-

refundable tax credits

¢  You may then complete the rest of the return as you normally would

Title Mr 1 JMarried 2 [ JLiving common-law 3 ] Widowed
E"s:%gzgfanes 4 |:| Divorced 8 |:| Separated 6 |X] Single

ast name
D e e T E 1 D Yes No If status changed in 2017, enter date of change mm-dd
Do you want to change your address? [l Yes No | Were you married or living common-law at any
Care of time in this tax year? [] Yes D No
gtgelsaoidress 1515 Orchard Street . - Apt # Residency
C:t.—An own o Province of residence
o on 2017/12/31 Ontario
%I\MA 1A9 M Province of self-employment
M If you became or ceased to be a Canadian resident in
Primary phone _ (905) 555-5121 2017, enter date of: entry 06-01
Birth date 1988-12-19 l Age 29 or departure - mm-dd
Date of Death _ yyyy-mm-dd .
— Spouse’s or common-law partner's net
Gender Male D Eemale income while the taxpayer is living in
Province or territory where taxpayer resides if different from mailing Canada 5263 0.00
address: M Spouse’s or common-law partner's net

. o . income while the taxpayer is living outside

ERA-IOHL:EE mél|, |:| Already reglsteredl:l Yes No of Canada 5267 0.00
Bmal ad ess: — od p— c Canadian sourced non-resident income 5292 10,000.00 I

y providing your email address or updating an already registere: X Ry -
email address, | understand | am registering for online mail and Foreign sourced non-resident |n.come 5293 19.000.00 I
accept the terms and conditions that are set out on page 2 of the form| Prorate non-refundable tax credits for part
T183. Paper notices will not be mailed to me from the CRA. year resident? m Yes D No
Do you want preparer to get Are you a non-resident? |:| Yes No
Electronic Notice of Assessment? D Yes No | Residency status Resident
By checking yes on the box above, | am allowing the CRA to Country (other than Canada)

Residency rules, for both Canadian citizens and non-Canadians, can be a complex affair. For more information,

consult CRA’s guides, such as T4058 Non-Residents and Income Tax, and T4055 Newcomers to Canada.




Chapter 5 Quiz

Question 1: The feature that allows you to prepare T1s for married couples and their dependants is called:

Hub and Link
Synchronization
ProFile Review
Family Linking

COowp

Question 2: True or False: ProFile will calculate the allowable RRSP deduction even if no deduction limit
indicated:

Question 3: Select the best way to create a dependant’s T1:

Go to the File menu and click New T

Right-click a T1 Jacket and select New

Click the Synchronize icon

Right-click the dependant’s name on the Dependant form, and click Return for...

COowp

Question 4: True or False: If a dependant has excess tuition credits, ProFile will transfer the excess amount to a
parent’s linked return

Question 5: True or False: ProFile has an option to toggle Family Linking on or off

Question 6: Which of following tax situations does ProFile’s Optimization verify?

Medical expenses
Charitable donations
Tuition credits

All the above

COowp

Question 7: True or False: The T1032 form allows you to optimize and split pension income between spouses

Question 8: True or False: ProFile cannot prepare tax returns for self-employed individuals



Question 9: To prepare a T2125, ProFile requires the following. Choose the best answer:

ProFile cannot prepare a T2125 return

A statement of revenue and expenses (Income Statement or Profit & Loss)
A balance sheet

None of the above

COowp

Question 10: True or False: ProFile can prepare a T1 for part-year residents







